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INTRODUCTION 
 
Welcome to Doing More with Word: Mail Merging.  This manual will instruct you 
on how to conduct mail merges in MS Word.  Through step-by-step exercises 
and detailed descriptions of the mail merge components, you will be able to gain 
an understanding of the mail merge process. 

 
A Mail Merge is useful for different kinds of documents: form letters, envelopes, 
labels, faxes, emails, and even Word document templates.  In each of these 
categories, there are fields that can be used for personalization, and the 
information meant for these fields can come from data sources such as Excel 
spreadsheets, Access databases, or from Word itself.  The mail merge 
methodology of adding placeholders and specifying data sources is an easier 
alternative to typing information relating to each member of the group, especially 
if the group is very large. 
 
 
 
Goals and Objectives 
 
Upon completing Doing More with Word: Mail Merging, you will be able to do the 
following: 
 

• Understand mail merge concepts 

• Choose a data source 

• Merge data 

• Understand data source concepts 

• Edit and modify a data source 

• Create and edit main documents 

• Test and inspect a merge 

• Merge records in order 

• Create new data sources 

• Select records to merge 
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Microsoft retooled the mail merge process with the Word 2007 release.  The new 
Mailings tab has replaced the Mail Merge Task Pane, and allows you to preview 
and edit your document as you proceed.  You can also use the Mail Merge tools 
to modify an existing mail merge as opposed to just using it to create a new mail 
merge.  Each step in the process contains short instructions as well as 
descriptions. 
 
The steps to complete a mail merge are as follows: 

 
1. Set up the main document  
2. Connect the document to a data source 
3. Refine the list of recipients or items 
4. Add placeholders, called mail merge fields, to the document 
5. Preview and complete the merge 

 
 
This manual has two sections.  The first section is centered around the Mail 
Merge Task Pane, while the second section is focused on the Mailings tab with 
its mail merge tools.  By going through these sections, you will be able to 
determine which approach to mail merging works for you.  
 

 
 
 
The first section is an introduction to mail merging through the Mail Merge Task 
Pane.    There are two exercises: the first has you conduct a mail merge to a 
form letter with an Excel Spreadsheet as the data source; the second has you 
create an Address List within Word, which you will make the data source for the 
form letter you created in Exercise 1.  In each exercise, you will become 
acquainted with each stage of the mail merge process. 
 
 
Once familiar with the concepts of mail merging, you will then proceed through 
the second module, which asks you to use the Mailings tab tools to develop 
envelopes for bulk mailings (after all, wouldn’t you need envelopes to go with the 
form letter that you have written?)  You will also learn the functionality of the tools 
and see how you can use it for your style of working. 
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INTRODUCTION TO MAIL MERGE 
 
Suppose you want to write a form letter.  You desire to say the same thing to 
everyone in your list, but you want to personalize each letter, starting with the 
printing of names and addresses.  Your list contains at least a hundred names, 
so it would take a long time to type each one.  Fortunately, the information in 
your list is contained in an Excel spreadsheet to which you have added a few 
entries at a time over the past several months.  You wonder if there is a way to 
incorporate the information from your Excel spreadsheet to your Word document. 
 
There is a way!  You can accomplish this by performing a mail merge.  Word will 
take the information from a data source that you specify (such as that Excel 
spreadsheet) and put it in placeholders in your document.  It is a multiple step 
process, but it is straightforward and allows you to be flexible. 
 
If this is your first time conducting a mail merge, here are a few definitions of 
terms that you will see throughout this manual. 
 
 
 

Data Source The source of information that is unique to each 
individual and changes in each merged 
document. 

 
Data Form An online form used to enter information into the 

data source.  Each screen includes all the fields 
of a data record.  This form enables you to add, 
delete, or modify records in the data source. 

 
Field names Headings for each column or category of 

information in the data source 
 

Merge fields Insertion points in the main document where 
data fields are merged. 

 
Sort To place items in a specific order, either 

numerically or alphabetically. 
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USING THE MAIL MERGE TASK PANE 
 
In this exercise, you will use the Mail Merge Task Pane to conduct your merge.  
Although each step of the merge contains descriptions and instructions, this 
section of the manual will give you detailed explanations along the way so you 
can gain a better understanding of the mail merge process.  The Mail Merge 
Task Pane is accessed through the Mail Merge Wizard. 
 
 

1. Start by opening a new document in Word.  You can do this one of three 
ways: 

 
a. Open Word.  A new blank document displays. 

 
b. On the Ribbon, click the Office Button and select New > Blank 

document > Create.  A new blank document displays.  
 

 
 

c. Type Ctrl and N.  A new blank document displays. 
 
 

2. On the Ribbon, click the Mailings tab.  The mail merge tools display. 
 

3. In the Start Mail Merge group, click the Start Mail Merge tool down-
arrow and select Step by Step Mail Merge Wizard.  On the right side of 
the window, the mail merge task pane displays step 1. 
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Select document type is the 1st step of the mail merge wizard.  The most 
common mail merge uses are for letters, envelopes, and labels.  Since you will 
be creating a form letter, leave the option button next to Letters selected. 
 

  
 
 

4. At the bottom of the task pane, click the Next: Starting document link. 
Step 2 of the wizard opens. 

 

  
 
 
Select starting document is the 2nd step of the mail merge wizard.  While you 
have a choice of using the current document, a Word template, or an existing 
document as your base for the mail merge, in this exercise you will use the 
current, blank document.   
 

1. Make sure that the first option button, Use the current document, is 
selected.   
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2. At the base of the task pane, click the Next: Select recipients link. Step 
3 of the wizard opens. 

 

 
 
 
 
Select recipients is the 3rd step of the mail merge wizard.  You are now ready 
to select the recipients for your mail merge.  This step is where you make the 
connection to your data source, in this case the Excel Spreadsheet beverage. 
 
Before connecting to the data source (in this case, the Excel spreadsheet), we 
will open it to view the records and layout. 
 

1. In the class files folder, open the beverage Excel spreadsheet file. 
 

 
 

2. Observe the 11 column headings or fields, which can be inserted into the 
Word document as mail merge fields, and the 5 records. 

 
Note that if formatting was applied to any of the records, such as colors or 
bolding, it would be lost.  This applies to Access records as well.  You can 
format the merge fields later in Word. 

 
3. Close the beverage Excel spreadsheet file. 

 
 

4.  Keep the option button next to Use an existing list selected.  
 

 
 
 

5. In the Use an existing list area, click the Browse link.   The 
Select Data Source window opens. 
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6. Navigate to the class files folder on the desktop and select the 
beverage.xls spreadsheet file. 

 

 
 
 

7. Click Open.  The Select Table window opens. 
 

  
 
 

8. Check to see that Sheet1$ is selected from the list. 
This is the sheet with the data on it.  Each worksheet in an Excel 
spreadsheet is regarded as a Table.   

 
 

9. Make sure that the checkbox next to First row of data contains column 
headers is checked.   
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10. Click OK. The Mail Merge Recipients window opens. 
 

 
 
 
This window allows you to view, select, and refine the recipients from your data 
source.  The information is presented as a table that can be sorted by column. 
 
 

11. Click OK.  The Mail Merge Recipients window closes. 
 
 
We will save our work and reopen the Mail Merge Recipients window. 
 
 

12. Save the file into the class files folder as mailmerge.docx 
 

13. On the Mail Merge pane, click the Edit recipient list link.  The Mail 
Merge Recipients window reopens. 
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SORTING AND FILTERING DATA 
 

 
 
 
Clicking the column headings (such as LastName) sorts the list in ascending 
order according to the information in that column.  Clicking the column headings 
again sorts the list in descending order.  This only changes the order of the 
records that have been fetched, but it does not change the actual data source. 
 
Adding or removing checkmarks adds or removes recipients from the merge list. 
 
Clicking the down-arrow in the column heading opens a menu of filters that can 
be used in processing the data.  You can use filters in order to ensure greater 
targeting of your recipients or just to narrow down your list for easier 
management.  The following table details the items in the menu; the items in 
parentheses are filters that are already built into Word. 
 
 

 Show all items 

 

Each distinct value in column - Click one of these 
values in order to show only the records containing 
that value in that column 

 Show all records with blank values in this column 

 Show any fields with nonblank values in this column 

 Opens the “Filter and Sort” window  
 
 
Once you select “Advanced,” the Filter and Sort window opens and is used to 
create a customized filter.  It has two tabs: Filter Records and Sort Records. 
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Filtering Records 
 
There are four basic form controls on the Filter Records tab: 
 

1. A drop-down box for each field name 
 
 

2. Drop-down box of Comparison conditions, which are: 
 

1. Equal to 
2. Not equal to 
3. Less than 
4. Greater than 
5. Less than or equal 
6. Greater than or equal 
7. Is blank 
8. Is not blank 
9. Contains 
10. Does not contain 

 
 

3. Text input field (Compare to:) to enter values to check against. 
 

 
 
 

4. Drop-Down boxes for And or Or logical conditions. 
 

 
 

a. Choose And when you need all the conditions to be met.  
b. Choose Or when you need one or more conditions to be met. 

 
 
One row of form items is activated at a time.  Choosing an option from the field 
drop down box in a row will activate that row’s Comparison and Compare to: form 
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items as well as the And/Or drop-down box and field drop-down box of the next 
row.  To deactivate a set of form items, select none from the field drop-down box. 
 
 
 
Sorting Records 
 
The Sort Records tab allows you to sort the records by up to three columns from 
the data source.  The first drop-down box in each row of form items contains the 
names of each column from the data source.  The two option buttons in each row 
correspond to the order in which you want to sort: Ascending (Alphabetical order 
from “A” to “Z”, Numerical order from 0 to 9) or Descending (Alphabetical order 
from “Z” to “A”, Numerical order from 9 to 0).  Selecting a column name from the 
drop-down box in a row will activate the option buttons in that row as well as the 
column name drop-down box of the next row.  Selecting (none) will deactivate 
these form items. 
 

 
 
 
At the bottom of the Filter and Sort window is the Clear All  button.  
Clicking this button will reset the form items on the active tab.  It does not affect 
the form items on the other tab. 
 
 

5. In the Mail Merge Recipients window, select the recipients that you would 
like to include in the mail merge by clicking the checkboxes.  By default, all 
recipients are selected.  
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If you want to clear all of the checkboxes, click the checkbox in the column 
heading.  All of the checkboxes are unchecked. 

 

  
 

If you want to select all of the checkboxes, click the checkbox in the 
column heading.  All of the checkboxes are checked. 

 

  
 
 
Other options for refining the recipient list: 
 

  
 
 
Sort   The Sort link opens the Sort Records window. 
 
 
Filter   The Filter link opens the Filter Records window. 
 
 
Find duplicates Clicking the Find duplicates link brings up a window that 

displays any duplicate records.  You can then select the 
entries you wish to include in your merge. 

 
 
Find recipient Clicking the Find recipient link brings up the Find Entry 

window which allows you to find a specific record. 
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Type the text for which you are looking in the Find field.  Then, click the option 
button that corresponds to either a search in every column of the data source or 
a specific column; if you are searching in a specific column, select its name from 
the drop-down box.  Clicking the “Find Next” button, which becomes active once 
text is entered in the text input box, conducts the search.  If an entry with the text 
is found, the row in the Mail Merge Recipients window is highlighted.  Otherwise, 
this error message appears: 
 

 
 
 
 
 
Validate addresses 
 
The Validate addresses link allows for verification of addresses with third-party 
software.   For more information, go to the Microsoft Office eServices page at: 

 
http://office.microsoft.com/en-us/marketplace/EY010497081033.aspx 

 
 
 
 
 
 
 

6. When you are done with the Mail Merge Recipients window, click OK  

.  The Mail Merge Recipients window closes and you are now 
ready to move to Step 4 of the merge. 

 
 
 
Note that some people skip these filtering and sorting steps and perform their 
sorting within Excel. 
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Write your letter is the 4th step of the mail merge wizard.  This is the step where 
you write the letter, insert the merge fields, and layout and format the letter. 
 

1. At the base of the Mail Merge pane, click the Next: Write your letter 
link.    Step 4 of the wizard opens. 

 
This is the step where you insert merge fields into your document.  At this point, 
you are now able to incorporate the information from your data source into your 
letter.  This is accomplished through special placeholders, into which information 
from the data source is placed.  Word interprets these field codes in order to 
display the content accordingly. 
 
You can specify which fields you want to include in the letter.  In this exercise, 
you will follow the “Address block…,”  “Greeting line…,” and “More items…” links 
to place merge fields in the form letter. 
 
 
We’ll begin this step by inserting an Address Block in the document.  Later in this 
manual, we will insert the individual components that make up the address block 
one by one. 
 

2. In the Mail Merge pane, click the Address block link  .  
The Insert Address Block window appears. 

 

 
 
 
The scrolling list in the Insert recipient’s name in this format field contains various 
permutations of formats for names, which not only includes ways of addressing 
the recipient but also ways of acknowledging the recipient’s spouse and family.  
The scrolling list is enabled when the Insert recipient’s name in this format 
checkbox is selected.  It is disabled when the checkbox is unchecked.  
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3. Select the format that you would like to use from the scrolling list.  Note 
the preview at the base of the window. 

 
4. Make sure the checkbox next to Insert company name remains checked if 

you wish to include the company name in the Address Block.  
 

 
 
 

5. Make sure the checkbox next to Insert postal address remains checked. 
The Preview field to the right reflects a sample address based on the 
options that you have selected.   

 
 

 
The option buttons corresponding to the Insert postal address field are enabled 
when a country or region field is detected in the data source.  The third and last 
choice is the most useful.  Our data source does not have a country or region 
field, so the options are grayed out.  
 

  
 
The Format address according to the destination country/region option instructs 
Word to apply any country or region specific formatting to the address such as 
number codes. 
 

 
 
When you have completed the Address block: 
 

6. Click OK. The Address Block placeholder is inserted into your form letter. 
 

 
 
 

7. Press Enter three times, to put two lines of space between the address 
and the greeting line. 

 
 
The next step is to insert a Greeting line. 
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1. In the Mail Merge pane, click the Greeting line… link . 
The Insert Greeting Line window appears. 

 

 
 
These options are useful if you decide not to type in the greeting line in order to 
consider various ways of starting your letter.  The Preview field shows a sample 
greeting line based on the options that you have selected. 
 
In the topmost row, in the Greeting line format field, the first and third drop-
down boxes are distinctive. 
 

 
 
You can either select one of the options from the drop-down box, or you can type 
in your own text.  Selecting a pre-made option from the drop-down box allows 
you to adhere to formal or conventional approaches to letter writing.  On the 
other hand, typing in your own text can be useful if you want to add an informal 
flavor to your correspondence. 
 

caution:  If you do choose to type in your text, bear in mind that it will 
be lost if you edit your Greeting line later.  In that case, you 
will need to re-enter your desired content. 

 
The second drop-down box contains various ways of addressing the recipient 
and his/her spouse. 
 
 
The Greeting line for invalid recipient names field contains text that will 
appear for an ambiguous recipient’s name. 
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Such cases arise when there is no first or last name field.  You can choose Dear 
Sir or Madam, To Whom It May Concern: or just a blank line, listed as (none). 
 
When you have completed the Greeting line: 
 

2. Click OK. The Greeting line block is displayed in the main document 
below the Address block. 

 

 
 
 

3. Press Enter twice, to put a space between the greeting line and the body 
of the letter. 

 
 
You are now ready to write the body of your letter by typing in the main document 
window. 
 

4. Type “Based on your interest in “ 
 
 
One option to add merge fields to personalize the letter is as follows.  (Later in 
this manual, we will use the Insert Merge Field tool on the Ribbon to insert merge 
fields.) 
 

5. In the Mail Merge pane, click the More items… link .  The 
Insert Merge Field window opens: 
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The two option buttons allow you to select from either the Address Fields or 
Database Fields. 
 

Address Fields consists of typical fields that are used by Word in 
addresses. 

 
Database Fields contain the specific fields (columns) of your data 
source. 

 
In either case, to insert a field into your document, you can either double-click the 

list item itself or single-click the list item and then click the Insert  
button  (or just press the Enter key). 
 
 

6. From the Insert Merge Field window, insert the Beverage merge field.  
The <<Beverage>> field is inserted into the letter. 

 

 
 
 

7. To close the window so that you can resume your typing, click the Close 
button .  The Insert Merge Field window closes: 

 
8. Add some more text regarding the person’s choice of beverage in your 

letter.  
 
 
Your letter will look something like this: 
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Making a Match 
 

The Match Fields… button  has been an option in these past few 
windows.  Clicking this button will allow you to see how Address Fields are 
matched to columns in your data source.  This matching is done either 
automatically by Word or specifically by you through the Match Fields window.  
 

1. To reopen the Insert Merge Field window, click the More Items… link. 
The Insert Merge Field window opens: 

 
2. In the Insert Merge Field window, click the Match Fields… button. The 

Match Fields window opens: 
 

 
 
 
The idea behind the Match Fields window is that it establishes a correspondence 
between the general fields of Word and the specific fields of the Data Source. 
 
Each row in the scrolling frame has a drop-down box that contains the name of 
each column (field) of the Data Source as well as an option that reads (not 
available). 
 
Word will pre-select the option in each drop-down box that best matches the 
name of the general address field.  If Word does not make a match, then (not 
available) is selected.  One caveat: if you have a field in your Data Source called 
Title, Word will pre-select the Title option in the drop-down box for Courtesy Title, 
even if you meant Title to correspond to the Word field called Job Title. 
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Clicking the OK button will commit any changes you make, while clicking the 
Cancel button will not. 
 

3. Check to see if the item selected in each drop-down box 
corresponds to the Address Field name; if you cannot make a 
correspondence, select the (not available) item in the drop down box.   

 

 
 

4. To return to the Insert Merge Field window, click OK.  The Match Fields 
window closes. 

 
5. Close the Insert Merge Field window. 

 
 
 
 
Preview your letters is the 5th step of the mail merge wizard.  To move to the 
next step (pane) to preview your letter: 
 

1. At the base of the Mail Merge pane, click the Next: Preview your letters 
link  . Step 5 of the Mail Merge, Preview your 
letters, appears. 

 
 
You may preview and cycle through your list of recipients by using the navigation 
buttons in the top section of the pane.  Click the  button to go to the next 
record in the list.  Click the  button to go to the previous record in the list.  
Click the  link to locate a particular record. 
 
Previewing the merge is useful in that you can ensure that the information from 
your data source is merged correctly. 
 
Tip: if you find that you have made a mistake in placing your merge fields or in 
matching the fields to your data source, in the Mail Merge pane, click the link that 
says, Previous: Write Your Letter  so that you can work in 
the previous pane. 
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If you need to change the recipient list in any way, you can do so in this pane.  
Clicking the  button will remove the record that is being 
previewed from the list.  On the other hand, if you want to add recipients to the 

list, you can click the Edit recipient list…  link to bring up the 
Mail Merge Recipients window. 
 

 
 
 

FORMATTING THE LETTER 
 
Once the merge fields have been inserted into the document and the body text is 
complete, you may want to format or adjust the layout of the document.  Font 
size, spacing, justification, and colors are just a few of the elements that can be 
altered.  For example, in the graphic above, the address block could be changed 
to single spacing. 
 
To format the address block: 
 

1. Select the address block text. 
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2. Right-click the selection.  The shortcut menu opens. 
 

3. From the shortcut menu, select Paragraph.  The Paragraph window 
opens. 

 

 
 
 

4. In the Spacing area, in the Line spacing field, select Single. 
 

 
 
 

5. Click OK.  The Paragraph window closes and the address block is 
adjusted to single spacing. 
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Tip for formatting data in Excel (from MS Excel Help) 
 
If your data file is an Excel worksheet that includes percentages, currency 
values, or postal codes, you can preserve the numeric formatting of the data by 
using Dynamic Data Exchange to connect to the Excel worksheet from Word.  
For example, you can make sure a five-digit postal code of 07865 from your data 
file is not displayed as the number 7865 (without the leading zero). 
 
Before you connect to the Excel worksheet, do the following in Word: 

1. Click the Microsoft Office Button , and then at the base of the 
window click Word Options.  The Word Options window opens. 

 
2. Click Advanced.  The Advanced options display. 

 
3. Scroll down to the General section, and select the Confirm file format 

conversion on open check box.  
 
  
 

4. Click OK.  The Word Options window closes. 
 

5. With the mail merge main document open, in the Start Mail Merge group 
of the Mailings tab, click Select Recipients, and then click Use Existing 
List.  

 
6. Locate the Excel worksheet in the Select Data Source dialog box, and 

double-click it.  
 

7. In the Confirm Data Source dialog box, click MS Excel Worksheets via 
DDE (*.xls), and then click OK.  

 
Note: If you don't see MS Excel Worksheets via DDE (*.xls), select the 
Show all check box. 

 
8. In the Microsoft Office Excel dialog box, for Named or cell range, select 

the cell range or worksheet that contains the information that you 
want to merge, and then click OK.  

 
Note: To prevent being prompted every time you open a data file, you can 
turn off the Confirm conversion at Open option after you have connected 
to the worksheet. 
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Complete the merge is the 6th and final step of the mail merge wizard.  Once 
you are done previewing the merge, you will want to complete the merge. 
 

1. In the Mail Merge pane, click the Next: Complete the merge link 
 . The last pane of the Mail Merge, Complete the 

merge, opens. 
 
At this point, you can complete the merge by either merging to the printer or 
merging to a new document.  Some people prefer the Merge to New Document 
option because it allows them to inspect the finished product before committing 
the job to the printer or they have the option to customize particular letters. 
 
To edit individual letters: 
 

1. In the Mail Merge task pane, click the Edit individual letters… link 
.  The Merge to New Document window opens. 

 

 
 

2. Make sure the option button next to All is selected in order to merge all 
records or select a print range. 

 
3. Click OK.  A new document, usually named Letters1, opens. 

 
With one page for each recipient; you can customize, save, and print this 
document just like you would with any other Word document. 

 
 
To print: 
 

1. In the Mail Merge task pane, click the Print… link.  The Merge to Printer 
window opens. 

 
2. Make sure the option button next to All is selected in order to merge all 

records or select a print range. 
 

3. Click OK.  Your printer window appears. 
Check your print settings, and print your letters. 
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DEFINING YOUR OWN DATA SOURCE 
 
Now that you are familiarized with the mail merge process, we will expand to 
define a new data source and merge its data into the form letter we just 
completed.  In this way, you will learn how to design a data source.   You will also 
see what it takes to incorporate another data source into an existing mail merge 
document. 
 
This new data source will be created using the Mail Merge Task Pane.  While 
you can design a data source using Excel or Access, the mail merge process will 
create a database table (in Access) with column names that are recognizable by 
both you and Word.  In fact, since this new data source will be called a Word 
Address List, each field in the source will be just like what you would find in each 
record of a Rolodex or personal organizer. 
 

1. Close the Letters1 multi-page document that was created by the merge, 
there is no need to save it. 

 
2. Make sure that the form letter document, mailmerge.docx, is still open. 

 
3. In the Mail Merge task pane, click the Previous link 3 times until you 

return to step 3.  The select recipients step displays. 
 

  
 
 

4. Click the option button for Type a new list.  The lower section of the 
pane changes accordingly.  
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5. Click the Create… link. The New Address List window opens. 
 

  
 
 
 
Adding Names to a Data Source 
 
The table is ready to accept data such as names and addresses.  To add a new 
listing: 
 

6. Begin typing. 
 

7. When the data is complete, either click New Entry  or Tab to 
the next row. The record is saved. 

 
8. To add another listing, begin typing again. 

 
Quick words of wisdom:  Enter just a few records and then test the mail 
merge.  Don’t enter all your records at this point.  If the test merge works, 
go ahead and add the rest of the records. 

 
 

9. When you are finished entering records, click the Close  button. The 
Save Address List window opens.   

 
10. Save the address file in the class files folder with a name of your 

choosing.  Note that the file type is .mdb (Access).  The Mail Merge 
Recipients window opens. 
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This window is just as you had seen earlier in the manual, but with a 
notable difference: the Edit button is now activated.  This means you can 
edit, add, and delete entries in your Address List, which is something that 
was impossible to do in the earlier exercise because the Data Source was 
an Excel spreadsheet. 

 
 
Editing Names in a Data Source 
 
To edit records in the data source: 
 

1. Click anywhere on the row of the record that you would like to edit. 
 

 
 
 

2. Click the Edit button.  The Edit Data Source window opens. 
 

3. Make changes to the record. 
 

4. Click OK. The Do you want to update… prompt appears. 
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5. Click Yes.  The table in the Mail Merge Recipients (the data source) is 
updated. 

 
 

6. Click OK to close the Mail Merge Recipients window. 
 
 
 
 
Invalid Merge Field Prompt 
 
We will proceed to complete the merge using this new data source so that the 
Invalid Merge Field prompt appears.  It will appear because as Word checks the 
merge prior to creating the letters, one of the fields that is being called for in the 
letter, the beverage field, is not in the data source. 
 

1. In the Mail Merge task pane, click the Next link 2 times until you 
attempt to Preview your letters in step 5.  The Invalid Merge Field 
window displays. 

 

  
 

  
 
 
Don’t worry: you have done nothing wrong.  Word brings up this dialog box when 
it performs an error check on the merge.  The error dialog indicates that there is 
a merge field that could not be resolved with the data source.  You can remedy 
this in one of two ways: 
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a. If there is a merge field that does not correspond to any of the fields 
of the Address List, click the Remove Field button.  Upon clicking, 
the merge field is removed. 

 
b. If you can replace the troublemaking merge field with a field from 

the Address List, select the field name from the drop-down box.  
The Sample Data text box updates with the content of that field 
from one record in the Address List. 

 
 

2. Click the Remove Field button  .  The Beverage field is 
removed from the document. 

 
Note that the Invalid Merge Field dialog window will appear for each 
instance of an unresolved merge field. 

 
 
With the merge fields resolved, you can now preview the mail merge and make 
changes to your recipient list.  You can also make any needed changes to the 
main body of your letter (which in our case would have to be done).  When you 
are done, continue the merge as outlined earlier in the manual. 
 
 
 
 

3. Close any Letter1 or Letter2 documents that may be open. 
 
 

4. Close the form letter document, mailmerge.docx. 
 
 

5. Feel free to view the MS Office Address List (in Access) that you created 
in the class files folder. 

 

  
 
 
 
 
 
 
 
 
 
 
 



University Information Technology Training & Documentation Department 33 

USING THE MAILINGS TAB 
 

ENVELOPES 
 
Now that you have successfully written a form letter with the assistance of the 
Mail Merge wizard, it is time to create an envelope with mail merge fields.  
However, instead of using the wizard, you will use the Mailings tools on the 
Mailings tab of the Ribbon.  The Mailings tools are useful because they let you 
add or change items related to the mail merge without having to search through 
the entire wizard.  
 
 

1. Open a blank Word document: Office Button > New > Blank document > 
Create. 

 
2. On the Ribbon, click the Mailings tab.  The Mailings tools display. 

 

  
 
 
 
We will now create an envelope layout for a mail merge using the Mailings tab 
tools. 
 

3. On the Mailing tab, Start Mail Merge group, click the Start Mail Merge 
down-arrow and select Envelopes.  The Envelope Options window 
opens. 
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You can define the envelope type and formatting that you are going to use and 
you can specify printing options. 
 
In the United States, the #10 envelope is the standard size.  It is pre-selected in 
the Envelope size field.  If none of the choices matches your envelope size, scroll 
to the bottom of the list, click Custom size, and then type the dimensions of your 
envelope in the Width and Height boxes. 
 

 
 
 
The  buttons for the delivery and return addresses allow you to format 
their appearance to your liking. 
 
The delivery and return addresses are also positioned automatically by Word, but 
you may override them by entering distances from the left and top of the 
envelope. 
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The Printing Options tab reflects your default printer and envelope feed choice.  
 

 
 
 

4. After setting your options, click OK.  The Envelope Options window 
closes and the window takes the shape of an envelope. 

 
 
Now that you have taken care of the envelope formatting, it is time to set up the 
mail merge.  As you might recall from the first exercise, there are two parts to this 
process.  First, you will define your data source, which will be the same Excel 
spreadsheet that we used earlier: beverage.xls.  Secondly, you will add your 
merge fields to the envelope. 
 
To define the data source: 
 

5. On the Mailings tab, Start Mail Merge group, click the Select Recipients 
down-arrow and select Use Existing List.  The Select Data Source 
window opens. 

 

  
 
 

6. On the Desktop, navigate to the class files folder and select 
beverage.xls. 

 
 

7. Click Open. The Select Table window opens. 
 

8. Select Sheet1$ from the list of three sheets. 
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9. Click OK. Nothing appears to happen but the other buttons/tools on the 
Mailings tab are now enabled. 

 
 
To check the correspondence to make sure that the fields between the data 
source and the merge fields are matched up correctly: 
 

10. On the Mailings tab, in the Write & Insert Fields group, click the Match 
Fields tool  . The Match Fields window opens. 

 
 

Check to make sure that the item selected in each drop-down box 
matches the address information. 

 

  
 
 

11. Click OK. The Match Fields window closes. 
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12. Click in the middle of the lower half of the envelope document to 
highlight the mailing address text area as follows: 

 

  
 
 
The next step is to place merge fields and text into the Delivery address box. 
 
Although we can place a regular Address Block in the text area as we did earlier, 
we’ll opt to add the merge fields one by one.  Thus, you can insert the Job Title 
and Department of each recipient in addition to the person’s name and street 
address. 
 
The Insert Merge Field tool is practical in that its dropdown menu allows you to 
insert each field by a single click of the item, add your formatting, and then add 
another merge field. 
 

13. Making sure that your cursor is still sitting in the Delivery address box, on 
the Mailings tab, Write & Insert Fields group, click the lower half of the 
Insert Merge Fields down-arrow.  A menu of available merge fields 
displays. 
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14. Select the merge field FirstName.  The FirstName merge field is 
inserted into the Delivery address box. 

 

  
 
 

15. On the keyboard, press the spacebar.  A space is added after the 
FirstName field. 

 
 

16. Again, click the lower half of the Insert Merge Fields down-arrow and 
select the merge field LastName.  The LastName merge field is inserted 
into the Delivery address box. 

 

  
 
 

17. On the keyboard, press Enter.  A hard return is added after the LastName 
field. 

 

  
 

18. Add the following merge fields to complete the envelope address delivery: 
 

JobTitle 
Department 
Address1 
Address2 
City 
State 
Zip 
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Don’t forget to add spaces and hard returns around fields. 
 
 
Your envelope Delivery address box should look like this: 
 

  
 
 
Before we take a look at the envelope with the source data represented, this is 
the time to format the addresses, if needed.  Font face and size, color, and 
alignment are some of the changes that can be made.  Formatting the mail 
merge fields will cause all of the generated envelopes to have the same 
formatting. 
 
To format the address: 
 

19. Select all of the merge fields. 
 

  
 
 

20. On the Home tab, generally in the Font group, make any formatting 
adjustments. 
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Tip for adding a graphic or image to the envelope 
 
If you wish to add a Tufts logo, image, or the like to the envelope, follow these 
steps: 
 

1. On the Ribbon, on the Insert tab, Illustrations group, click the Picture, 
Clip Art, or any other tool for inserting a graphic.  Various windows will 
open. 

 
2. Insert the graphic or image onto the mail merge document. 

 
 
To be able to freely move the graphic into position on the envelope: 
 

3. Right-click the graphic or image.  The shortcut menu appears. 
 

4. Select Text Wrapping > Square. 
 

 
 

5. Drag the graphic into position. 
 

6. Resize or make any other adjustments to the graphic. 
 

 
 
See the Visual Identity System, http://universityrelations.tufts.edu/?pid=190 , for 
other Tufts related graphics and tips. 
 
 

 

http://universityrelations.tufts.edu/?pid=190�
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To see how each envelope will look when data from the spreadsheet is placed in 
each merge field: 
 

21. On the Mailings tab, in the Preview Results group, click the Preview 
Results tool.  The merge fields display the spreadsheet data. 

 

  
 
 
To scroll through the individual envelope addresses: 
 

22. In the Preview Results group, click the Record navigation arrows.  
Spreadsheet data displays. 

 

  
 
 

23. You may click the Preview Results tool at any time to toggle between the 
merge fields (where adjustments can be made) and the data. 

 
 
The last step will be to complete the merge and create the addressed envelopes.  
 
 
Before completing the merge, if you wish to simulate the merge to see if the 
merge will be successful, you can use the Auto Check for Errors tool. 
 
 

7. In the Preview Results group, click Auto Check for Errors 
.  The Checking and Reporting Errors window opens. 
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8. Click the first option: Simulate the merge and report errors in a new 
document. 

 

 
 
 

9. Click OK.  This simulation should perform without errors.  
 

  
 
 
To complete the merge and create the addressed envelopes: 
 

24. On the Mailings tab, in the Finish group, click the Finish & Merge tool.  
Three options display. 

 

  
 
 
At this point, you could select the second option, Print Documents…, but I prefer 
to see a print preview before I send the whole job to the printer. 
 
By selecting Edit Individual Documents you can customize individual envelopes, 
save, and print this document as you would any other Word document. 
 
The Send E-mail Messages option sends email messages from within Word 
using MS Outlook. You need an email field in your source data to use this option. 
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25. Select the first choice, Edit Individual Documents… The Merge to New 
Document window opens. 

 

  
 
 

26. With the All option selected, click OK.  The New Document Envelopes1 
opens. 

 
 
Rather than printing all of the envelopes, we suggest that you print out one 
envelope to make sure that the printer setup is in order. 
 

27. Select Office Button > Print > Print.  The Print window opens. 
 

28. If needed, make your printer adjustments. 
 

29. In the Print range area, select Current page. 
 

  
 

30. Click OK.  The envelope prints. 
 

31. Verify that the envelope printed correctly. 
 
 
After successfully printing the envelopes, you may save the Envelopes1 
document, or you can delete the Envelopes1 document.  You still have the 
original formatted envelopes document containing the mail merge fields that can 
be reused for your next mailing.  All you need to do is make sure that the source 
data document (in our example, the mailmerge.docx document) is up to date. 
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In the future, when reopening the main document for the merge, this window will 
appear: 
 

 
 
as Word attempts to reconnect to the data source.  Click Yes to reconnect. 
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LABELS 
 
The last process we will look at is the creation of labels using merge fields and a 
data source.  We will follow many of the same steps that were just covered in the 
previous section on creating envelopes with the Mailings tab tools. 
 

1. Open a blank Word document: Office Button > New > Blank document > 
Create. 

 
2. On the Ribbon, click the Mailings tab.  The Mailings tools display. 

 

  
 
 
We will now select a label layout for a mail merge using the Mailings tab tools. 
 

3. On the Mailing tab, Start Mail Merge group, click the Start Mail Merge 
down-arrow and select Labels.  The Label Options window opens. 
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You can define printer information, label supplier or vendor, and the label type or 
number. 
 

1. Select the print options.  Most printers use a stack bypass tray for label 
feeding. 

 

  
 
 

2. Select the label vendor. 
 

  
 
 

3. Select the label product number. 
 

  
 
 
You may also make adjustments to the label dimensions by clicking the Details 

button  or create your own label layout by clicking the New Label 

button .   
 
 

4. After setting your options, click OK.  The Label Options window closes 
and the window takes the shape of a sheet of labels. 

 
 
Now that you have taken care of the label formatting, it is time to set up the mail 
merge.  Again, there are two parts to this process.  First, you will define your data 
source, which will be the same Excel spreadsheet that we used earlier: 
beverage.xls.  Secondly, you will add your merge fields to the labels. 
 
To define the data source: 
 

5. On the Mailings tab, Start Mail Merge group, click the Select Recipients 
down-arrow and select Use Existing List.  The Select Data Source 
window opens. 
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6. On the Desktop, navigate to the class files folder and select 
beverage.xls. 

 
 

7. Click Open. The Select Table window opens. 
 

8. Select Sheet1$ from the list of three sheets. 
 

9. Click OK. The cursor rests in the first label field, the <<Next Record>> 
placeholders display, and the other buttons/tools on the Mailings tab are 
now enabled. 

 
 
The next step is to place merge fields into the first label position on the sheet.  
You only need to concern yourself with this first label, as all of the subsequent 
labels will be generated automatically. 
 
Using the Insert Merge Field tool: 
 

10. Make sure that your cursor is still sitting in the first label, on the Mailings 
tab, Write & Insert Fields group, click the lower half of the Insert Merge 
Fields down-arrow.  A menu of available merge fields displays. 

 

  
 
 

11. Select the merge field FirstName.  The FirstName merge field is 
inserted into the label. 
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12. On the keyboard, press the spacebar.  A space is added after the 
FirstName field. 

 
 

13. Continue to add fields as you did in the envelope exercise. 
 

  
 
If the merge fields don’t fit into the label, or you see truncated merge fields (see 
the graphic above), you have three choices: 
 

a. Use a bigger label 
b. Decrease the font size 
c. Use fewer fields 

 
We will decrease the font size. 
 

14. In the first label only, click and drag to select the merge fields, being 
careful to select them all. 

 

 
 

15. On the Home tab, in the Font group, select a smaller font size.  The 
label merge fields should all be visible. 
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To check the label when data from the spreadsheet is placed in each merge field: 
 

16. On the Mailings tab, in the Preview Results group, click the Preview 
Results tool.  The merge fields display the spreadsheet data. 

 

  
 
 

17. You may click the Preview Results tool at any time to toggle between the 
merge fields (where adjustments can be made) and the data. 

 
 
Before completing the label merge, you need to update all of the labels on the 
sheet.  If you do not update the labels, each sheet of labels will print out with just 
one address from the data source per sheet. 
 

18. On the Mailings tab, in the Write & Insert Fields group, click the Update 
Labels tool.  The merge fields display across the entire sheet. 

 

  
 
 
To complete the merge and create the sheets of labels: 
 

19. On the Mailings tab, in the Finish group, click the Finish & Merge tool.  
Three options display. 
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At this point, you could select the second option, Print Documents…, but I prefer 
to see a print preview before I send the whole job to the printer. 
 
By selecting Edit Individual Documents you can customize individual labels, 
save, and print this document as you would any other Word document. 
 

20. Select the first choice, Edit Individual Documents… The Merge to New 
Document window opens. 

 

  
 

21. With the All option selected, click OK.  The New Document Labels1 
opens. 

 
 
Rather than printing all of the labels, we suggest that you print out one sheet on a 
plain piece of paper to make sure that the printer setup is in order. 
 

22. Select Office Button > Print > Print.  The Print window opens. 
 

23. If needed, make your printer adjustments. 
 

24. In the Print range area, select Current page. 
 

  
 

25. Click OK.  The sheet of labels prints. 
 

26. Verify that the labels printed correctly by holding the printed sheet up to 
the light with the blank vendor supplied sheet behind it to see that the 
addresses fit into the blocks. 

 
After successfully printing the labels, you may save the Labels1 document, or 
you can delete the Labels1 document.  You still have the original formatted labels 
document containing the mail merge fields that can be reused for your next 
mailing.  All you need to do is make sure that the source data document (in our 
example, the mailmerge.docx document) is up to date. 
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